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Preface

Preface

CyberLink PowerDirector 9 has all the tools you need to edit your family videos and 
become a vlog superstar on YouTube. Whether you are an advanced editor or a new to 
creating video editing, CyberLink PowerDirector will have you making professional 
looking video productions in no time. 

About This Book
This book guides you through the CyberLink PowerDirector program and gives 
examples of some commonly used editing techniques for creating video productions. It 
also outlines all the latest features of CyberLink Director 9, and includes helpful tips 
and tricks for using the program.
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Introduction
1-1 New Features in PowerDirector 9
CyberLink PowerDirector 9 has many new features that enhance program performance, 
and make the editing process easier and more flexible. The following is an overview of 
the new features in CyberLink PowerDirector 9.

1-1.1  TrueVelocity Native 64-bit 
Engine 

TrueVelocity is a state-of-art technology developed by CyberLink that combines 
hardware and software resources to provide the best performance and speed available 
for video editing. 
CyberLink PowerDirector 9 Ultra64 is the first native 64-bit consumer video editor 
available and is the leading video editing software in the industry. Compared with 32-
bit editors, the TrueVelocity 64 bit engine of CyberLink PowerDirector 9 allows you to 
edit high definition video clips more smoothly.
TrueVelocity also enhances program performance and stability of 32-bit computers, 
allowing you to fully focus on video editing and creativity process.
3



1-1.2  Full HD High Definition 
Preview 

CyberLink PowerDirector 9 
Ultra64 includes full HD 
preview, which allow you to 
view your production in full 
HD video in real-time .

Note: The full HD and HD 
preview feature is only 
available in CyberLink 
PowerDirector 9 Ultra 64 
when installed on a 
Windows 64 bit system.
4



Introduction
1-1.3  Supports More Media 
Formats 

1-1.4  Enhanced Timeline Editing 
Behaviour 

The enhanced timeline of CyberLink PowerDirector 9 lets you add up to 100 video and 
audio tracks to the workspace.  The new timeline behavior removes old limitations and 
allows for more freedom when editing your videos.

Import Export

Video formats
• HD MPEG-2, DVR-MS, DV-AVI, 

DAT, DivX (codec preinstallation is 
required), MPEG-1, MPEG-2, VOB, 
VRO, ASF, WMV, WMV HD, MOV, 
MOD, TOD AVCHD, MPEG-4, 
AVC (H.264), .ts, .mts, .m2ts, WTV 
(single channel)

• New formats: MKV, FLV, Canon 
DSLR video, Nikon DSLR video

Image format
• GIF; BMP; JPG; TIF; PNG
• New format: RAW (Canon/Nikon)

Audio format
• WAV; MP3; WMA; M4a 

Video formats
• DV-AVI, MPEG-1, MPEG-2, 

MPEG-2 HD, AVCHD(H.264), 
WMV, WMV-HD, MPEG-4, 
MOV(QuickTime)

Single audio file output 
• M4a, WMA, WAV

Network Upload 
• Upload the Full-HD high definition 

video to YouTube / Facebook
Export to mobile devices 

• Sony PSP, iPod, iPhone, 
iPad, PocketPC, SmartPhone, Zune

Disc-burning format
• BD-R, BD-RE, AVCHD, DVD-/

+R, DVD-/+RW, DVD-DL, VCD
• New format: BDXL high capacity 

Blu-ray Disc.
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Up to 100 tracks for editing 
available.

All media (including videos, 
images, effects, and audio 
clips) can be added, moved, 
copied, or edited on the 
tracks freely.

Set the track height freely 
for better preview.
6



Introduction
Use the enhanced Track 
Manager for efficient 
management of the timeline 
tracks.

Group videos, images, 
effects, and audio clips for 
ease of movement in the 
workspace. 

Separate and edit the audio 
in a video clip using the 
Unlink function. 
7



Linked Audio & Video

Unlinked Audio & Video

Set track names to keep 
better track of media in your 
production.
8



Introduction
   

1-1.5  Advanced Audio Editing with 
CyberLink WaveEditor 

Unused tracks can be easily 
removed from the timeline.

CyberLink WaveEditor is an 
audio editing program in 
CyberLink PowerDirector 9 
that includes the following 
features:
• Precise audio trimming
• Volume level adjustment
• Audio speed controls
• Add effects to your audio 

clips
• Import and add VST 

(Virtual Studio 
Technology) effects to 
your audio clips
9



1-1.6  Keyframe Settings Room
The keyframe settings room in CyberLink PowerDirector 9 allows you to make more 
precise edits and adjustments on media clips and effects in your projects. 

1-1.7  3D Magic Style Templates 
CyberLink PowerDirector 9 now includes six Magic Style 3D templates you can use to 
create productions quickly.

In the keyframe settings 
room you can: 
• Adjust particle effect 

settings
• Apply video 

enhancements more 
precisely.

• Fine tune video effect 
settings. 

• Set video and image 
opacity 
10



Introduction
1-1.8  Amazing Animation Effects 

1-1.9  Upload Full HD Video Clips to 
YouTube / Facebook 

Use the Particle Designer to 
create amazing effects in 
your video, such as snow, 
fireworks, and explosions.

CyberLink PowerDirector 9 
lets you upload videos in full 
HD to Facebook or YouTube 
directly from within the 
program.
11



1-1.10  Exporting to Mobile Devices 

1-1.11  Audio Output 

In CyberLink PowerDirector 
9 you can output your video 
production to a format 
compatible with most 
popular mobile devices, such 
as iPad, iPhone, Blackberry, 
PSP/PS3, and many Android 
devices. 

You can now output in an 
audio only format to create 
ring tones and other custom 
audio projects.
12



Introduction
1-1.12  Disc Creation & Burning  

1-2 Quick Start Tips
Before you get started on a video project, review the following tips on how to get the 
most out of the CyberLink PowerDirector 9 program.

• Advanced Menu 
Designer with more 
menu templates added.

• Create disc menus that 
are easy to navigate.

• Quickly burn Blu-ray, 
AVCHD video, or DVD 
discs in a wide variety of 
formats, including the 
latest BDXL format that 
supports up to 128 GB of 
video.
13



1-2.1  CyberLink PowerDirector 9 Overview
CyberLink PowerDirector 9 includes the following four modes: 

Capture: Capture media to use in your video.
Edit: Use your media to create a video production through various editing techniques.
Produce: Output your video production as a video or audio file in a variety of formats.
Create Disc: Create a disc menu and burn your video production to a disc.

Capture mode
In the Capture window you can capture media from a variety of sources and then 
import it into your project library for use in your video production. 
14



Introduction
Edit Mode
In the edit window you build and edit your video production using all the media in your 
project library.

The content available in the 
library window is dependent 
on which room you are 
currently within. When the 
For example, when the 
Particle room option is 
selected, the library window 
displays the available 
particle effect templates in 
your library.
15



Produce mode
In the Produce window you can output your final video production to a media file, 
external device, or upload it to Facebook or YouTube. CyberLink PowerDirector 9 
supports a variety of media formats for output.

When you select media on 
the editing workspace 
(timeline or storyboard), the 
advanced function buttons 
become available above the 
workspace.
16



Introduction
Create Disc Mode
In the Create Disc window you can burn your video production to disc with a 
customized menu.

1-2.2  Workspace Introduction
The workspace has two different views: the Timeline and Storyboard views. The 
following outlines the differences between them.

To toggle between the timeline view and the storyboard view:

Click the buttons on the top-
left corner of the editing 
workspace. 
17



Storyboard view

The storyboard view 
displays thumbnails of all 
the media (images and 
videos) in your video 
production. This view gives 
a more visual example of 
what your final production 
will look like. However, 
there are less editing features 
available in this view.

The workspace also displays 
the total length of the project 
and the length of a specific 
media clip.
For example, the example 
media clip named 
Nature.mpg displays 
00;00;17;01 when placed 
on the workspace, which 
means the length of the clips 
is 17 seconds and one frame. 
(The media length is 
displayed in the hour; 
minute; second; frame 
format) In addition, the total 
length of the project is 
00;00;42;01, meaning that 
the length of the project is 42 
seconds and one frame.  
18



Introduction
Timeline view

1-2.3  Track Manager 
In CyberLink PowerDirector 9 you can add up to 100 video and audio tracks to the 
timeline workspace. The tracks on the timeline also allow for more flexibility when 
placing media and effects into your production . 
The following examples outline how to perform certain functions on the timeline.

The timeline view is for 
more advanced video 
editing. All of the editing 
features of CyberLink 
PowerDirector 9 are 
available in this view.
19



Add a track

Move the mouse to the 
timeline edge and drag it to 
the right. The track name 
will be displayed.

1. Click  to open the 
Track Manager.
20
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2. The Track Manager 
includes two parts: video 
and audio tracks. Input a 
number between 1 and 99 
in the video track box to 
add new tracks. Set the 
Position of the newly 
added tracks, and then 
add the required audio 
tracks in the same 
manner. Click OK to 
continue.

3. The new tracks are added 
to the workspace.

Tip:Right click on the 
timeline and select Add 
Tracks in the pop-up menu 
to quickly display the Track 
Manager at any time.
21



Remove a Track
To remove a track, see the following steps:

Move the mouse to the 
unwanted track and then 
right click the mouse. Click 
Remove Track in the pop-
up menu. The track is 
removed from the timeline.
22



Introduction
Remove Empty Tracks
The Remove Empty Tracks function is used to quickly remove unwanted tracks from 
the timeline. 

1. Right click on the timeline 
and then click Remove 
Empty Tracks in the pop-
up menu.

2. All the empty tracks are 
removed from the 
timeline.
23



1-2.4  Resizing the Timeline 

You can resize the timeline 
at any time to get a better 
view of  a specific track or 
your entire project.

Zoom in on the timeline
Move the mouse to the 
timeline ruler. When the 
cursor becomes a blue clock 
icon with two arrows, drag 
the cursor to the right. The 
timeline is zoomed in.

Zoom out the timeline
Move the mouse to the 
timeline ruler. When the 
cursor becomes a blue clock 
icon with two arrows, drag 
the cursor to the left. The 
timeline is zoomed out.
24



Introduction
View Entire Project
To view your entire video 
production at once, move the 
mouse to the timeline ruler 
and then right click the 
mouse. Click View Entire 
Movie in the pop-up menu.

Adjust Track Height
If there is a large amount of 
tracks in the editing 
workspace, you may find 
viewing media difficult. 
Adjust track height to get a 
better view.

Move the mouse to the top 
border of editing workspace 
and an up/down arrow 
cursor is displayed. Drag the 
cursor up to expand the 
height of the editing 
workspace.
25



Setting Track Height
The editing timeline workspace has three custom track size -  small, medium, or large. 
You can set the desired track height as required.

Right click the mouse on the 
track and a pop-up menu is 
displayed. Click Adjust 
Track Height option and 
then select the desired track 
height from the sub menu.

Track Height  - Small 
26



Introduction
1-2.5  Project Basics
The following introduces the basic project features in CyberLink PowerDirector 9.

Track Height  - Medium

Track Height  - Large
27



Creating a new project

Saving a Project

To create a new project, 
click File >New Project.

Note: Click   if the 

File menu is not currently 
displayed.

1. Once a project is created or 
opened, click File>Save 
Project to save the project 
at any time during the 
editing process.

Note: The extension name 
of a project file is .pds.
28



Introduction
Creating a New Workspace
When a new workspace is created, only the editing workspace is cleared. All media in 
the library window is maintained.

2. If this is the first time you 
are saving the project, 
input a project name and 
then click the Save 
button.

3. When the project was 
saved, the project name 
displays on the title bar.

1. Click File > New 
Workspace.
29



Exporting a Project
The project export function lets you back up your video production, and creates a copy 
for editing on another computer environment. You can export projects to a folder on 
your computer or a connected external device.
See the following steps to export a project.

2. An empty workspace 
replaces the old one.

1. Click File > Export and 
then select Pack Project 
Materials.
30
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2. In the pop-up dialog, 
select the folder where 
you want to export the 
project to.

Note: CyberLink 
PowerDirector places the 
project file and all the media 
that is currently being used 
in the project in the export 
folder. Any media that is in 
your library, but not in the 
project workspace is not 
included.

3. Click OK to continue.

4. Once exported, the 
project file and its media 
is included in the folder.
31



1-2.6  An Introduction to Using 
Keyframes 

Keyframes let you make more precise edits in your productions and give you more 
control over effects, enhancements, and more. Keyframes are frames of your video that 
define the start and end points of an effect or enhancement.
There are two circumstances during the editing process when you can use keyframes in 
CyberLink PowerDirector 9:

(1) When modifying enhancements and effects on the timeline.
(2) When modifying effects in a number of the designers available.

(1) Modifying enhancements and effects on the timeline in the Keyframe Settings
room.
The Keyframe button is available in the function area, when you are able to use 
keyframes to modify an enhancement or effect on the timeline.
Example: Add a fade in using the opacity effect.

1. Select the media you want 
to apply the effect to in the 
timeline and then click the 
Keyframe button.

Add a keyframe
1. Select Opacity to display 

the available settings in the 
panel. Drag the timeline 
indicator to the preferred 

position and then click  to 
add a keyframe. 
32
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2. The new keyframe is 
indicated by a red 
diamond. Set the opacity 
level to 0. This will be 
the start of the fade in 
effect.

3. Move the timeline 
indicator to the point 
where you want the 
media clip tpo be 
completely visible, and 

then click .

4. Set the opacity level to 
100. This will be the end 
of the end of the fade in 
effect. Click Play in the 
preview window to 
preview the fade in 
effect.
33



(2) In various effect designers of CyberLink PowerDirector, including the PiP 
Designer, Particle Designer, Title Designer and the Magic Motion Designer.

Example: Add motion to photos in the Magic Motion Designer.

To open the Magic Motion Designer:

Tip:you can add as many 
keyframes as you like for 
more precise control over 
the fade at different points in 
the video

5. To remove an unwanted 
keyframe from the panel, 
select it and then click the 

 button. 
34
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To use the Magic Motion Designer:

Select an image on the 
timeline and then click the 

Magic Motion button  
to display the Magic Motion 
window.

Select a Magic Motion 
template and then click the 
Motion Designer button to 
open the Magic Motion 
Designer.

1. The first keyframe 
indicates where the focus 
on the image (displayed 
in the small preview 
window on the left) 
begins in the image.
35



2. Resize the focus area box 
to display the entire 
image.

Note: The preview window 
displays a change in the 
focus area.

3. Drag the timeline 
indicator to the next 
position and then click 

 to add a new 
keyframe.

Note: the motion in this 
example is to zoom in on the 
photo.
36
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4. Move the timeline 
indicator to the last 
keyframe and resize the 
focus area box to the 
location on the image you 
want.

5. Drag the timeline 
indicator to a third 
position and then click 

the  button.
37



1-2.7  Signing up to DirectorZone
DirectorZone is a free web service from CyberLink that lets you search, download, and 
use PiP objects, title templates, particle objects, and disc menus in your projects. You 
may also share your own customized effects and videos on DirectorZone.

Before you can start downloading and sharing, you need to register with DirectorZone 
and get a user account.

6. Click and drag the third 
keyframe to change the 
path of the motion zoom 
effect, focusing on a 
different portion of the 
image. 

7. Click Play to preview the 
motion effect.
38
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1. Click Sign in to 
DirectorZone on the top-
right corner of the window 
to display the sign in dialog.
39



2. Click Get an Account.

3. The browser is launched 
and goes to the 
DirectorZone website 
automatically. Click Sign 
up on the top of the page.
40
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4. Fill in the fields as 
required and then click 
Next.

5. When this page is 
displayed, enter the 
required data and then 
click Submit.

6. You are taken back to the 
home page of the 
DirectorZone website 
and your account is now 
logged in.
41
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Basic Editing Techniques and Media Management
in CyberLink PowerDirector - Part I
This chapter outlines basic editing techniques that you will use frequently in CyberLink 
PowerDirector. It also shows how you can better manage your media to make the 
editing process more efficient.

2-1 Media Management in 
CyberLink PowerDirector 

Use the explorer view of CyberLink PowerDirector to manage all the media in your 
library, so you can easily find it when you need it.

Viewing and managing media in explorer view

1. Click Edit to access 
the edit mode and then 

click  to display the 
explorer view.

2. Click  to add a 
new folder
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Importing media (by media files)

3. Give the folder a 
custom name by 
renaming it.

Note: To rename or delete 
the folder, just right click 
on the folder to display the 
pop-up menu.

1. Click  and the 
select Import Media 
Files.
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2. In the Open dialog, 
browse to the folder 
that contains the media 
and select the it. Click 
Open to continue.

3. If you are importing 
high definition video, 
the following message 
displays. Click Yes to 
continue.

Note: CyberLink 
PowerDirector 9 supports 
the import of full HD 
video, which requires 
more computing power to 
edit. CyberLink 
PowerDirector creates 
shadow files and activates 
GPU acceleration (if 
availble) for smoother 
editing.
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4. The imported media 
files will be displayed 
in the library window.

Note: If you only want to 
import media of a specific 
type (i.e. only video, 
audio, or image files) in a 
folder, you can filter it by 
selecting the file format 
from the drop down above 
the library window, before 
clicking the import button

Tip:Media is usually one 
of two aspect ratios - 4:3 
or 16:9. Make sure your 
project aspect ratio syncs 
with the aspect ratio of 
your media, to ensure the 
most desirable results.
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2-2 Splitting clips
The video splitting function is used frequently in the editing process. It simply splits a 
media clip into two separate portions on the timeline.

1. Click  to switch to 
the Storyboard view.

Note: For beginners, we 
suggest using the 
storyboard view to split 
media, because it offers a 
more visual example of 
the split process.

2. Drag the desired media 
clip to the first cell in 
the storyboard view.
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3. In the preview 
window, move the 
timeline indicator to 
the position where you 
want to split the clip 
and then click Split.

4. The media clip is 
separated into two 
different clips.

Note: splitting and 
triming media clips does 
not affect or change the 
original source clips used. 
CyberLink PowerDirector 
just makes note of these 
functions and then applies 
them to the final video 
during production. 

5. Move the timeline 
indicator to another 
position in the media 
clip and then click 
Split again.
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6. The video will be split 
again.

7. Repeat the previous 
steps to split the clip as 
often as you like.

Note: the Split button is 
inactive if the timeline 
indictor is at the very 
beginning or end of the 
media clip.

8. To remove an 
unwanted clip, right 
click on it and then 
click Remove. The 
clip is removed from 
the workspace.

Note: You can also click 
the delete key on your 
keyboard to delete the clip 
from the workspace.
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2-3 The Fade in Effect 
Fades are the most widely used effects in video productions. Learning how to do them 
quickly and correctly will maximize your editing time.

Adding the fade-in effect

9. The split process is 
complete.

1. Click Timeline View 
to enter the timeline 
workspace.

Tip: use the zoom in 
slider in the bottom left 
corner to zoom in or out 
on the timeline if 
necessary.

2. Click the first media 
clip in your production 
and then click the  
Keyframe button.
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3. In the Keyframe 
Settings window, click 
the arrow in front of 
Opacity to expand the 
settings panel.

4. Ensure the timeline 
indicator is at the 
beginning of the clip 
and then click  to add 
a keyframe.

Note: This example 
illustrates how to create a 
fade-in effect from black.

5. Move the time 
indicator to position 
00;00;02;14 and then 
click  to add another 
keyframe. Ensure the 
opacity level is at 100.
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2-4 Power Tools – Video Speed
The Power Tools in CyberLink PowerDirector let you easily perform the following 
editing functions: – Video in Reverse, Video Crop, and Video Speed.

The following example illustrates the use of the Video Speed tool to increase playback 
speed of a video clip.

6. Select the first 
keyframe and then set 
the opacity value to 
zero.

Note: Setting the opacity 
value to zero makes the 
media background 
completely black.

Tip:You can view the 
keyframes in the 
thumbnail of the media 
clip. The upward or 
downward line represents 
the change in opacity 
levels in this example.
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Video Speed

1. Select a video clip on 
the timeline and then 
click Power Tools.

Tip:Click  to save your 
current project so you do 
not lose any edits.

Note: You can use all 
three Power Tools 
together to create a unique 
video effect.

2. Select the Video  
Speed checkbox and 
then move the speed 
multiplier slider to 3X. 
You can preview the 
effect by clicking Play.

3. Click X to close 
Power Tools when you 
are done.

4. When CyberLink 
PowerDirector has 
applied a Power Tool 
effect, a power man 
icon is added to the 
clip in the timeline.
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2-5 Adding Titles
Add titles to your videos to include opening and closing credits, or other text to your 
video production.

Adding a title

1. Click  in the 
Rooms panel to open 
the title room and then 
select All Content.

2. Drag the default title 
template to the title 
track.

Note: you can add title 
templates to the video 
track in CyberLink 
PowerDirector 9.

3. Double click the title 
template to open the 
Title Designer.
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Changing the text, color, and size of a title

4. Double click in the 
title box.

1. Enter the required text 
in the title box.

2. Click the font color 
button in the top-right 
corner.

3. In the color dialog, 
select the color white 
and then click OK.
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Title Alignment

4. Change the font size to 
60.

Note: If the desired font 
size is not listed in the size 
combobox, you can input 
the font size directly in the 
font size field.

1. Click the text box and 
then click the 
alignment button in the 
bottom-right corner. 
Select Center in both 
the upper and lower 
parts of the menu.

Note: The upper part of 
the menu is for the 
horizontal alignment, 
while the lower part is for 
the vertical alignment.
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Adding Text Animation
In this example we will add a fade in and out animation to the title text.

2. Set the desired font to 
finish.

1. In the Title Designer, 
click  to set the 
text’s  animation.
59



2. Click the More button 
beside the Starting 
Effect. The Starting 
Effect dialog is 
displayed.

3. Click Fade to set the 
fade-in effect. Click 
OK to continue.
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2-6 Saving the Title Template
The customized title template you created can be saved so you can use it in video 
projects.

4. Click the More button 
beside the Ending 
Effect. The Ending 
Effect dialog is 
displayed.

5. Click Fade to set the 
fade-out effect. Click 
OK to close the dialog.
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1. Click  in 
the Title Designer.

2. Input a name of the 
custom template and 
then click OK.

3. Click OK again to 
close the Title 
Designer.
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2-7 Using Color Boards 
Color boards are really useful as backgrounds for titles and ending credits.

4. Open the explorer 
view and then click the 
Custom folder to 
display the saved 
template. 

1. Click the Media 
Room button and then 
select Color Boards.

2. Drag the desired 
background color for a 
title to a video track 
and click Duration.

3. In the Duration 
Settings dialog, set the 
duration and then click 
OK.
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2-8 Using a Custom Title Template
You can use custom title templates to save production time.

4. The selected color 
board is added on the 
track.

1. In Edit mode, click 
Title Room ( ) and 
then select the Custom 
folder.
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2. Drag the custom title 
template to the a 
second video track or 
title track, and then 
align it with the color 
board clip added 
previously.

3. Make the length of the 
title clip equal to the 
color board clip. 
Double click the title 
clip to open the Title 
Designer.

4. Input your desired text. 
Center the title text, 
both horizontally and 
veriticality as done 
previously. 

5. Click OK when you 
are done.
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2-9 Range Selection 
Range Selection lets you easily select a portion of your video production for copying 
and cutting purposes. You may wish to reuse an edited segment elsewhere in your 
production, or quickly cut it for pasting in another part of the video.
The following continues from the previous editing example.

1. Move the time 
indicator to the color 
board clip.

2. Click the yellow 
triangle on the right 
side of the timeline 
indicator and then drag 
it to the end of the 
color board clip.
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3. Click the yellow 
triangle on the left side 
of the time indicator 
and then drag it to the 
beginning of the color 
board clip.

Note: All the content on 
the timline that will be 
duplicated is highlighted 
in yellow. 

4. Click the Copy button 
in the function buttons 
above the timeline.

5. Move the timeline 
indicator to the end of 
your video production 
and then click Paste.
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2-10 Magic Music – Quickly Add 
Background Music

If you do not have any royalty free music available for your video production, you can 
use Magic Music to add music.

6. The duplicated content 
is added to the new 
position in the 
timeline.

7. If necessary, double 
click the title clip to 
modify the text if 
required.

8. In the Title Designer, 
change the title 
properties and then 
click OK.
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1. Click  to open the 
Magic Music library 
panel.

Tip:When you use Magic 
Music for the first time, 
click the SmartSound 
button to open the 
Library Update dialog. 
Click Update Now to 
download all the latest 
tracks available.

2. Click Accept. Decide 
if you want to copy the 
sound files to your 
hard drive.
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2-11 Muting Audio in a Video Clip
When using background music or voice over dialogue in your video production, 
conflicts in audio levels can occur between the original audio in video clips and the 

3. Select the music style 
combobox and then 
select the desired 
music style. Select a 
song use and then click 
the desired variation. 
Click the Play button 
in the preview window 
to listen to the music.

4. If you decide you want 
to use a song you 
previewed, drag it to 
the audio track and 
then ensure the track 
length is equal to the 
project length.

5. Click Play in the 
preview window to 
preview your video 
production with the 
background music. 
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added audio. You can easily turn off the original audio in the video clip to keep audio 
focus on the added music or voice over.

1. On the track that 
contains the video 
clips with the audio 
you want to mute, click 

 next to the audio 
track of the video clip. 

2. When the icon is an X, 
it means the audio 
track is inactive and 
will not be included in 
the final video.

Tip:You can also mute the 
sound of a specific video 
clip. Right click on a 
video clip and then select 
Mute Clip.
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2-12 Exporting Your Production as an 
MPEG-2 (.mpg) file

You can export your completed project as an MPEG file for playback outside the 
program and for sharing with others.

1. Click the Produce 
button.

2. Click the MPEG-2 
option and then click 
the button to set 
where the outputted 
file is created.
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3. Set output location and 
then input a file name. 
Click Save to return to 
the Produce window.

4. Click Start to beging 
the the production 
process.

5. The production 
process starts and 
displays a progress bar.
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6. When the production 
process is complete,  
remember to save your 
project .

7. Go to the folder you 
specified in step 3 and 
then play created video 
using a media file 
player, such as 
CyberLink 
PowerDVD.
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This chapter continues the overview of the commonly used editing and media 
management features of CyberLink PowerDirector 9. 

3-1 Extracting Audio from Video Clips
The Extract Audio function in CyberLink PowerDirector 9 separates the audio track 
recorded with the video, and saves it as a new audio file for use in your projects.

1. In a new project, click  
to display the Explorer 
View. Click  and then 
select Import Media 
Files. 
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2. In the Open dialog, 
browse to and then select 
a video file. Click Open 
to continue.

Tip: CyberLink 
PowerDirector 9 now 
supports .flv and .mkv video 
files.

3. Once the video file is in 
your media library, right 
click on it and then select 
Extract Audio.
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3-2 Importing Media in a Folder
If all of the media you want to use in your production is contained in a single folder, 
you can import it all at once using the Import Media Folder function.

4. When the Save as dialog 
is displayed, select where 
on your computer you 
want to save the new 
audio file, enter a file 
name if necessary, and 
then click Save.

5. The new audio file is 
added to your media 
library.

Note:  the extracted audio is 
saved in the .wav file format.
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Importing Media Folders

3-3 Turning Your Images into 
Slideshows 

In CyberLink PowerDirector 9 you can quickly take your images and turn them into 
dazzling slideshows in a few simple steps. The Slideshow feature of CyberLink 

1. Click  to display the 
Explorer View. Create a 
new folder for the 
imported files, give it a 
custom name, and then 
ensure it is selected. 

2. Click  and then select 
Import a Media Folder.

3. When the dialog is 
displayed, browse to and 
select the folder that 
contains all your media. 
Click OK to continue.

4. All the media in the 
selected folder is 
imported and added to 
the folder you just added 
to your media library.
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PowerDirector 9 has nine slideshow template styles to choose from: Cell, 3D, Collage, 
Scrapbook, Montage, Highlight, Motion, Normal, and Camera. 
Creating a Slideshow

1. Drag the images you 
want in the slideshow 
from the library to the 
timeline workspace.

2. Ensure all the images on 
the timeline are selected 
and then click the 
Slideshow button.

Tip: To select all images on 
the track, click the first 
image, press the Shift key on 
your keyboard, and then 
click the last image on the 
track. You can also click and 
drag your mouse over then 
to selected them.
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3. In the slideshow wizard 
window, select the 
desired style template 
and then click Next to 
contunue.

4. You can click Play to 
preview the the 
slideshow. If you are 
satisfied with the results, 
click Next to continue.

Note: If you want to apply 
another slideshow style 
template, click the Previous 
button to go back.

5. Click Finish to close the 
slideshow wizard.
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Changing the Slideshow Style

6. A confirmation message 
is displayed. Click OK to 
continue.

Note: When the slideshow is 
added to the timeline, any 
effects or titles you added to 
the selected images 
previously are removed. 

1. Select the slideshow 
created previously on the 
timeline and then click 
Slideshow.
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2. In the slideshow wizard, 
select another style 
template and then click 
Next.

3. Click Next.

4. Click Finish to exit the 
wizard.
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3-4 Adding Transitions
You can also create slideshows with your images manually by adding transitions 
between images on the timeline. You can add transitions between both image and video 
clips.

Add a single transition

5. When the confirmation 
message is displayed, 
click OK.

6. The slideshow has been 
changed.

1. Drag some images to a 
video track and then click 

 to access the 
transition room.
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Tip: There are four types of tranitions: the cross, overlap, prefix, and postfix 
transitions. You can utilize the different transitions to generate a different transition 
effect.
• Cross Transition: for cross transitions, the two clips are side by side on the timeline 

and the transition acts like a bridge between them. For example, if you add a two 
second transition between two four second clips, the total duration is eight seconds. 
The transition begins at the three second mark of the first clip, and ends at the one 
second mark of the second clip.

•

A cross transition works on both clips.
• Overlap Transition: for overlap transitions, the two clips overlap when the 

transition is taking place. This allows for parts of the two clips to play over each 
other during the transition. Using the same example as above, the total duration is 
six seconds, with the transition playing for two seconds over both clips.

An overlap transition works by combing the two clips during the transition
• Prefix Transition: you can add a prefix transition to the beginning of a clip. Prefix 

transitions work only on a single clip, and are useful for fades or on PiP clips in your 
productions

2. Drag the desired 
transition to the borders 
between the first two 
image clips.
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A prefix transition only works on one clip.
• Postfix Transition: postfix transitions are added to the end of a single clip. They do 

not affect any clips that may follow it in the timeline..

A postfix transition is applied to the end of a clip.

Adding Common Used Transitions to Favorites
If there are some transitions you use often in your production, you can add them to your 
favorites so you can access and apply them more quickly.

Tip: For easier editing of 
transition length and 
placement, zoom in on the 
timeline for a better view.
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1. Go to the transition room 
and then right click on a 
transition you use 
frequently. Select Add to 
Favorites.

2. Repeat the previous step 
and add other transitions 
to the My Favorites 
folder.

3. In the Explorer View , 
select the My Favorites 
folder to view the added 
transitions.

4. Click  and then 
select Apply Random 
Transition to All > 
Cross Transition.
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3-5  Creating Picture in Picture 
Effects 

Media that displays over other media in your production is called the PiP (Picture in 
Picture) effect. Using PiP effects in your productions can make your videos much more 
engaging to viewers.

5. All the transitions in your 
favorites are applied to 
the media on video track.

Note: You can use the 
“Random” feature at any 
time to apply transitions to 
your production. The 
program will randomly 
apply transitions in the 
selected library folder 
between all the clips on the 
selected track.

Tip: To delete a transition 
from the My Favorites 
folder, right click the 
transition thumbnail and 
then click Remove from 
Favorites.
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Using Backgrounds
CyberLink PowerDirector 9 also includes image backgrounds you can use in your 
video productions, if you want to use something other than the solid color of a color 
board.

1. To access the 
backgrounds in your 
library, open the 
Explorer View and then 
select Backgrounds.

2. Drag a background image 
to the first track in the 
timeline to use it as the 
background in your 
video.
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Changing Clip Position in the Video Frame

1. Click the media folder in 
the Explorer View and 
select Video from the 
drop-down list of media 
types.

Tip: User can filter the 
media type that is displayed 
in the library (i.e. just show 
videos, images, or audio 
files) by using this drop-
down.

2. Drag a video file to the 
timeline.

Tip: Once on the timeline, 
you can do the following to 
the video file once it 
selected: resize it, change its 
position in the video frame, 
or rotate it.
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Adding new video tracks
Add tracks to the timeline, beneath the original track, so that you can add PiP media on 
top of the current video in your production.

Resize the clip: You can 
resize the clip so that it only 
displays on a portion of the 
video frame. To do this, 
move the cursor to the 
bottom-right corner of the 
clip, and when the dual 
arrow is displayed, click and 
drag the cursor to resize it in 
the frame.

Change the clip position: 
You can position the clip any 
where you like in the frame. 
To do this, move the cursor 
to the center of the clip and a 
cross cursor is displayed. 
Click and drag the cursor to 
the desired position in the 
frame.

Rotate the clip: You can 
changed the orientation of 
the clip in the frame. To do 
this, move the cursor to the 
blue circle, and when the 
cursor becomes a dual-arc, 
click and drag the cursor 
clockwise or 
counterclockwise to rotate 
the clip.
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1. Click  to open the 
Track Manger and add 
new tracks to the 
timeline.

2. In the Track Manager, 
add two video tracks and 
then set the track position 
below the original track. 
Click OK to exit.

Note: You have to input the 
number of tracks in the 
Video section to add the new 
tracks.

3. If required, right click on 
the timeline and then 
click Adjust Track 
Height > Small to 
decrease the track height. 
This allows the timeline 
to display more tracks.
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3-6 PiP Effect - Overlapping Clips 
You can overlap several video clips and images in your video production using the PiP 
effect. See the following steps to overlap images and video clips.

4. The size of the tracks was 
updated.

1. Drag a clip to a to the 
second video track in the 
timeline.
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2. Set the duration of the 
added clip to match the 
duration of the original 
video clip.

Note: you can still use a 
background image as the 
background for your PiP 
effect. Just add it to the third 
video track and then click 
and track the track to the top 
of the timeline as shown.

3. Drag a clip to another 
video track and then set 
the duration to be the 
same as all the other 
existing clips on the 
timeline.
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4. Use the resize and rotate 
features on your clips, 
and change their position 
to fine tune the PiP effect. 

Tip: The order of the PiP 
object is related to the order 
of the video tracks. The 
tracks at the top of the 
timeline, appear at the 
bottom of the image. For 
example, track 3 and 4 are 
over track 2, and track 1 is 
the bottom layer.

1. Click the clip you want to 
add a frame to and then 
click the Modify button.
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2. In the PiP Designer, click 
.

3. Click the Heart frame 
from the template list and 
then click .
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4. Select the Apply border 
checkbox and then click 

 to set the border.

5. In the Border dialog, 
select the Uniform color 
option.
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6. Select a color and then 
OK. 

7. Click Close to exit the 
Border dialog.

8. The frame is applied to 
the clip. Click OK to 
exit.
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Adding More Frames

1. Click another video track 
and then click Modify. 
(In this example, click 
track 2.)

2. In the PiP Designer, 
click .
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3. Click the desired frame in 
the template list and then 
click OK.

4. Repeat steps 1-3 to add 
another frame onto the 
last clip.

Note: You can reposition the 
clips anywhere in the video 
frame one by one. 
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3-7 Adding PiP Objects
The PiP Objects room has static, objects, and frame objects that you can add to your 
video productions.

1. Click  and then drag 
the desired object onto to 
a new track. (In this 
example, drag to track 5, 
which you can add to the 
timeline if necessary.)

Note: The added PiP object 
in this example displays over 
the other clips added 
previously. If you want to 
move it below, see the 
following steps.

2. Click  to oepn the 
Track Manager.
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3. Add a video track and set 
the track position to 
Above Track 3. The new 
track is added as track 2.

4. Drag the PiP object you 
previously from added 
from track 5 to track 2.

5. Resize the PiP object so 
that its duration matches 
the other clips.
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3-8 Burning Your Production to a Disc
You can output your production as a video file or burn it to a disc for playback on disc 
player.

Project Importing & Burning

6. The results of the added 
PiP object will look 
something like this.

1. Click Create Disc.

2. Click  to add 
additional videos to your 
disc.

Note: You can also import 
other CyberLink 
PowerDirector projects and 
burn them to the same disc.
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Add a Chapter

3. In the Open dialog, 
browse to the video file 
you want to add to the 
disc, select it, and then 
click Open.

1. Click Menu Structure 
to view the current 
structure of the disc.
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2. Click  to exit the menu 
structure window.

Note: The Content tab 
displays all the current 
projects and all imported 
videos that will be burned to 
the disc.

3. Move the mouse to the 
project we added 
previously, and then 
select Show Chapters.
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4. You can view all the 
chapters in the display 
panel. Click  to go to 
the Chapter Room to add 
chapters to your video 
production.

5. You can add as many 
chapters as required in 
the Edit mode.
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Setting the Chapter Thumbnail

6. Move the timeline 
indicator to a position 
you want to add a chapter 
and then click  to add 
a new chapter.

Note: You can add chapters 
to your video production 
based on scenes or events in 
your video. Just go to the 
beginning of the scene and 
click .

1. Move the timeline 
indicator to a moment in 
your video that has an 
image you want to use as 
the thumbnail, and then 
click .

Note: The chapter thumbnail 
will be displayed in the disc 
menu.
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2. Click Create Disc.

3. Click Show Chapters.

4. The chapter was 
modified.
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3-9 Menu Templates in CyberLink 
PowerDirector

With DirectorZone, CyberLink PowerDirector 9 has access to hundreds of menu 
templates you can use in your video productions. You can also create custom templates, 
which you can then upload to DirectorZone to share with others.

Changing the Menu Template

5. Repeat the previous steps 
to change all the chapter 
thumbnails, if required.
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1. Click the Menu 
Preferences tab and then 
select a template.

2. Click Apply to All 
Pages.
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Changing the Menu Text

3. The menu template was 
changed.

1. Click Menu Structure.

2. Click the top item in the 
menu structure tree. 
Double click the title box 
in the Disc Menu 
Preview Window and 
then change the menu 
text.
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Preview and Burning

3. Click the another item in 
the menu structure tree. 
Follow the previous step 
to change the menu text.

4. You can also change the 
postion and font size of 
the menu text.

1. Click Preview to view 
what your disc will look 
like once burned.
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2. Click X to close the 
preview

Tip: If the total burning size 
is over the disc capacity, you 
can select Smart Fit in the 
Quality drop-down on the 
Disc Preferences tab. 
CyberLink PowerDirector 
will compress the video size, 
so that it fits on the disc, 
without compromising 
quality.

3. Click Burn.
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3-10 Modifying Default Menu Templates

Changing the Menu Background

4. When the Final Output 
dialog is displayed, click 
Start Burning.

Note: Insert a disc before 
burning.

1. Click Menu Preferences 
and then select a 
template.
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2. Click Modify.

1. In Menu Designer, click 
 to change the menu¡¦s 

background.

2. In the Open dialog, 
browse to and then select 
the image you want to 
use. Click Open to 
continue.
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3. Click Crop if the 
Conflicting Aspect 
Ratio dialog displays.

4. Click Yes when the 
message is displayed.

5. The menu backgroung 
was changed.
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Adding Images to Menus

1. In the Menu Designer 
dialog, click  to add 
an image.

2. In the Open dialog, 
browse to and select the 
image you want to add, 
and then click Open.
118



Basic Editing Techniques and Media Management
in CyberLink PowerDirector - Part II
Change buttons

3. Change the position and 
size of the added image 
as required.

1. In the Menu Designer, 
click the Edit drop-down 
list and then select Titles/
Chapters Menu.
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2. Click  (Set button 
properties).

3. Click  and then click 
the preferrred button 
layout.

Note: The button layouts 
available are dependent on 
the specific template used.
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Adding Video Effects to Menus

1. In the Menu Designer 

click .

2. When the Select the 
Video Effect dialog is 
displayed, select an 
effect. Click OK to exit.
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3. Click Play to preview the 
video effect on the disc 
menu.

4. Click  to stop the 
preview.
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Upload the Custom Menu Template to DirectorZone

1. Click Share in the Menu 
Designer.

2. Input the template name 
and then click OK.

3. Input your account name 
and password to log in to 
DirectorZone. 

Note: If you do not have an 
account on DirectorZone, 
click Get an Account.
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4. Input the description of 
the template and then 
click Next.

5. Check I have confirmed 
the above desclaimer 
and then click Next.

6. The upload begins
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7. Once uploaded, select the 
Click here to view the 
template link.

8. The customized template 
was uploaded to 
DirectZone.
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Chapter 4

Advanced Editing
Techniques in CyberLink

PowerDirector - Part I
4-1  Creating a Movie 

Opening Countdown
4-7  Applying Movement to 

Your Images
4-2  Taking a Snapshot 

from a Video Clip 4-8  Customizing Particle 
Effects4-3  Adding Titles

4-9  Unlinking Video and 
Audio in Video Files4-4  Uploading Custom 

Title Templates to 
DirectorZone

4-10  Splitting Audio

4-11  Manually Adding an 
Audio Fade4-5  Creating a Stop 

Motion Video 4-12  Uploading your 
production to 
Facebook4-6  Using Particle Effects



This chapter outlines some of the more advanced editing features in CyberLink 
PowerDirector 9. Even though these techniques take a little longer to learn, they are 
still easy enough to be used in your video productions after just a few hours of practice. 

4-1 Creating a Movie Opening 
Countdown 

You can create a movie opening countdown by adding several images together. See the 
following steps for details.

1. Create the countdown 
images outside 
CyberLink 
PowerDirector in a 
graphics program, and 
then import then into 
your media library. Drag 
the images to a video 
track in the correct 
countdown order.

2. Select all the images on 
the video track and then 
click Duration.
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3. Set the duration to 1 
second. Click OK to 
continue.

4. Select all images and 
then drag them to another 
empty video track.

5. In Explorer View and 
open the Color Boards 
room, and then drag a 
color board to the first 
video track. Match the 
duration of the color 
board clip to the duration 
of the added image clips.
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4-2 Taking a Snapshot from a Video Clip
You can take a snapshot of a frame of video in one of your clips, and then use it in your 
video production. CyberLink PowerDirector saves it as a .bmp image by default, and 
adds it to your media library.

6. Click Play in the preview 
window to view the 
created movie opening 
countdown.

Note: You can zoom in or 
out on the timeline for a 
better view of your 
production.
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Zooming in the Preview Window
When adjusting a media clip's size, orientation, and position in the video frame, 
CyberLink PowerDirector allows you to zoom in and out on the preview window to 
simplify the task.

1. Drag a video clip to an 
empty video track. Move 
the timeline indicator to 
the frame in the video 
you want to capture, and 

then click .

2. In the file name dialog, 
give the captured image 
snapshot a cutom name is 
required, and then click 
OK.

3. The captured image is 
saved to your media 
library.
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1. Drag the captured image 
to the video track.

2. Resize the image in the 
preview window so that it 
exapands beyond the 
preview window's border, 
i.e. outside the video 
frame.

3. Change the preview 
window zoom to 50% to 
zoom out on it. This 
allows you to view the 
contents of the image 
outside the video frame .
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4-3 Adding Titles 
The following reviews some of the more advanced formatting options available of title 
templates when using the Title Designer. 

Adding a Title Template

4. Change the size and 
position of the image so 
that is is centered in the 
frame.  

5. Doing this allows you to 
create a zoom in effect on 
the image clip.

1.  (Following the previous 
examples) Select the 
Title Room and then 
drag a title template to 
the desired video track.
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Modifying the Title Template

2. Change the position of 
the title in the video 
frame in the preview 
window.

1. Double click on the title 
clip to open the Title 
Designer.

2. Double click on titile text 
in the preview panel to 
edit it, if required.
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3. Highlight the title text.

4. Set the text style and then 

click  to change the 
font color.
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Modifying Title Text Color - Color Gradients

1. Select the Gradient 
color option and then 

click  next to the 
Begin with option.

2. In the Color dialog, select 
the desired color and then 
click OK.

3. Change the gradient 
direction if necessary.

Tip: If you want to change 
the gradient direction, 
simply click on a direction in 
circle directly. Do not try 
and drag the direction 
indicator.
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Adding Title Text Shadows

1. Click  to display 
the shadow setting panel. 
Select the Apply shadow 
option and then the Fill 

shadow box. Click   
to set the shadow color.

2. In the Color dialog, select 
the desired color and 
click OK to continue.
138



Advanced Editing Techniques and Media 
Management in CyberLink PowerDirector - Part I
Changing Title Text Borders

3. Change the shadow 
direction if necessary.

Note: If you want to change 
the shadow direction, simply 
click on a direction in circle 
directly. Do not try and drag 
the direction indicator.

1. Click  to display 
the border panel. Select 
Apply border and then 
the Uniform color box. 

Click  to set the 
border color.

2. Select the desired color 
and then click OK.
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3. The border color was 
changed.

Note: You can use a color 
gradient for the border color 
if necessary. 
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Changing Title Text Alignment

1. In the Title Designer, 
select the title text and 
then click . Select 
Center from the drop-
down list to align the text 
to the center of the text 
box.

2. Click OK to close the 
Title Designer.
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4-4 Uploading Custom Title Templates to 
DirectorZone

You can upload your title template to DirectorZone to share it with others and back it 
up on the Internet.

3. Set the duration of the 
title clip to be the same as 
the image clip.

1. Double click on the 
customized title template 
on the timeline to open 
the Title Designer.
142



Advanced Editing Techniques and Media 
Management in CyberLink PowerDirector - Part I
2. In the Title Designer, 
click the Share button 

.

3. In the Save As Template 
dialog, give the template 
a custom name and then 
click OK.
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4. Enter the account name 
and password and then 
click OK.

Note: Click Get an Account 
if you do not have a 
DirectorZone account.

5. Enter the template 
information and then 
click Next.

Note: You need to fill in all 
the fields.
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6. Select the I have 
confirmed the above 
disclaimer and then click 
Next.

7. The upload process 
begins.

8. When the upload is 
complete, click the Click 
to see your template 
link. Your template will 
be listed on 
DirectorZone.
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9. Click Home to exit the 
dialog.

10.Click OK to finish.
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4-5  Creating a Stop Motion Video 
Many of the latest digital cameras support the burst (rapid 
shooting) feature. In CyberLink PowerDirector you can easily put these images 
together to create a stop motion video.

1. Take a series of images 
using the burst feature on 
a camera, and then import 
them into your CyberLink 
PowerDirector media 
library. Drag all of the 
images a video track.

Note: Ensure the images are 
in sequential order on the 
timeline.

2. Select all of the images, 
and then click Duration.
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4-6 Using Particle Effects 
In the Particle Room you can add, modify, and create particle effects such as fireworks, 
snow, and explosions to your video production. 

3. Set the duration each 
image will display in the 
final video and then and 
click OK.

 

Tip: To make a stop motion 
video, the duration of each 
image should be quite short 
for better results.

4. Click Play in the preview 
window to see the 
resulting video.

1. Click  to open the 
Particle Room and then 
drag the a particle object 
to a video track.
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2. Change the size of the 
particle object so that it is 
larger than the image 
behind it.

3. Click  to add a video 
track and then position it 
above track 1.

4. Go to Color Boards 
room in Explorer View 
and then drag one to the 
newly added track.
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Using Particle Effects as a Background

5. Match the duration of the 
color board clip to the 
duration of the images, as 
in this example.

1.  (Using the the previous 
example) Add a new 
video track and position 
it above track 1. Drag a 
particle object to the 
newly added track.

2. Remove the colorboard 
clip (added previously) 
and then change the 
length of the added 
particle object.
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4-7 Magic Motion - Applying Movement to Your 
Images  

If you are not satisfied with the static images in your production, you can use Magic 
Motion to add movement to them. Adding movements makes your images more 
engaging and greatly enhance your video production.

1. Drag the image you want 
to add motion to on the 
timeline and then and 

then click .

2. Select the motion style 
template from the list and 
then click Motion 
Designer.
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3. Select the first keyframe 
on the keyframe timeline.

4. Move the focus area box  
to a different position. 
Resize if necessary. 

Note: In the example, you 
will learn how to pan the 
focus across the image.

5. Move the timeline 
indicator to another 
position and then click 

 to add a keyframe.
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6. Change the focus area 
box position and size as 
required.

7. Move the timeline 
indicator to the another 
position and then click 

 to add a keyframe.

8. Move the blue diamond 
(keyframe indicator on 
the motion path) to 
another location. This 
moves the focus area box 
position on the time. 
Click OK to finish.
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Duplicate Keyframe
Using the duplicate keyframe can save you a lot of time when using keyframes, and 
add effects like paused motion in your Magic Motion images.

1.  (Following the previous 
example) Move the 
timeline indicator to 
another position and then 
click  to duplicate the 
keyframe.

Note: The duplicate 
keyframe function copies 
properties of the keyframe 
before or after it on the 
keyframe timeline.

2. Select Duplicate 
Previous Keyframe 
from the pop up menu.

Tip: the resulting effect of 
duplicating the keyframe in 
this example will have the 
focus pause movement at the 
current position.
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3. Move the timeline 
indicator to the last 
keyframe on the timeline, 
and then change the 
position and size of the 
focus area box.

4. Click Play to preview the 
final result. Click OK to 
exit Magic Motion.

Tip: To delete a keyframe, 
select it and then click .
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4-8 Customizing Particle Effects 
Particle effects are one of the most powerful editing features in CyberLink 
PowerDirector 9 and offer a lot of creative potential that is unlimited. You can 
download additional particle effects customized by other users, and upload any effects 
you want to share with others to DirectorZone.

5. Change the duration of 
the image clip on the 
timeline.

Note: If you find the motion 
is too fast, just extend the 
duration of the image clip to 
slow it down.

1. In the Particle Room, 
drag a particle object to a  
video track and then click 
the  Modify button above 
the timeline.
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2. In the Particle Designer, 

click  to add a new  
particle object to the 
effect.

3. Select an emit method 
first, or how the particle 
will appear in the effect. 
Next, click Select 
particle style.

4. Select a preferred style 
from the list.

Note: By combining 
different styles and emit 
methods, you can have 
diverse effects in your video 
project. If you are unsure 
what the effect is, click Play 
to preview it.
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5. If you would like to 
change the particle image 
used in the effect, select 
Add/Delete particle and 
then click . You can 
add a default image or 
your own custom image.

6. In the Open dialog, select 
the image you want to 
use and then click Open.

7. You can preview the 

effect by clicking . 
Stop the preview by 
clicking .

Note: The preview must be 
stopped before you can 
change/update any settings.
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8. Select a particle image 
that was added by default 
and then click  to 
remove it.

9. Click Modify 
parameters.

10.Set the parameters as 
required and then click 

 to exit the settings 
panel.
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11.If you would like to 
delete a specific particle 
object, click  to delete 
it.
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Saving Custom Particle Objects

1. Click Save  .

Note: If you would like to 
share your custom particle 
object with others, you can 

click  to upload 
it to DirectorZone.

2. In the Save As Template 
dialog, enter a custom 
name for your effect and 
then click OK.

3. The particle object was 
saved.
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4-9 Unlinking Video and Audio in Video Files 

In CyberLink PowerDirector 9, not only can you extract audio from a video clip and 
use it in your production, but you can also unlink the audio from a video clip on the 
timeline.

1. Drag the desired video 
file on to an empty video 
track.

2. Right click on the video 
clip and then click 
Unlink Objects.

3. The audio and the video 
in the clip are no longer 
connected, and can be 
moved independently 
from each another.
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4-10 Splitting Audio 
If your video production is longer than the background music you want to use, you can 
use the audio clip repeatedly to extend its length. On the contrary, if your video 
production is shorter than the background music, you can simply split the audio clip 
and remove the excess portion. 

4. If you would like to 
delete the video portion, 
select it and then press 
the <Delete> key on your 
keyboard.

5. The audio was unlinked 
from the video.

1. Move the timeline 
indicator to the position 
where you want to split 
the audio clip and then 
click the Split button.
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2. If you want to keep the 
second of the two new 
clips, select and then 
delete the first clip.

3. Move the second clip to 
be beginning of the 
timeline.

4. Repeat the previous steps 
until the length of the 
audio clip is the same 
length as the video 
production.

Tip: You can also click and 
resize the end of the second 
audio clip in this example to 
shorter its duration more 
quickly.
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4-11 Manually Adding an Audio Fade 
You can use a fade effect in your video production so that the audio fades 
out at the end, instead of ending suddenly. 

5. Click Play to preview the 
production.

1. Move the timeline 
indicator to the position 
on the audio clip where 
you want the fade out to 
begin.

Tip: You can increase the 
height of the audio track for 
a better view.
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4-12 Uploading your production to Facebook 

If you have an account, you can upload your finished video production to Facebook 
and share it with your friends.

2. Click the volume level 
line in the audio clip to 
add a volume key as 
shown in.

Tip: The volume level line 
extends throughout the clip. 
You can drag the volume key 
up to increase the volume, or 
drag it  down to decrease the 
volume.

3. Move the mouse to the 
very end of the audio clip 
and then click again to 
add a second key.

4. Drag the ending key 
down.

Note: When the volume 
level slopes up, the volume 
is increased. When the 
volume line slopes down, the 
volume is decreased.
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1. Click Produce.

2. Click the Facebook tab.

3. Set the profile type, title, 
and description and then 
click Start.

Note: You can upload your 
production to both 
Facebook and YouTube 
directly in the Produce 
window.
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4. Click Authorize to 
continue.

5. Enter your Facebook 
account name and 
password and then click 
Login.

Note: If you do not have a 
Facebook account, click 
Sign up for Facebook to 
create one.
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6. Once authroization is 
complete, CyberLink 
PowerDirector will begin 
producing your video.

7. Once produced, it is 
uploaded to Facebook.
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8. When the upload is 
complete, click on the 
Check out your video 
on Facebook link to see 
your production. 

9. Click Play to preview 
your production.
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This chapter continues with the overview of some of the more advanced, but powerful 
editing techniques in CyberLink PowerDirector 9.

5-1 Improving Video Quality and 
Correcting Video Clips 

If you are not satisfied with the source video clip because of bad image quality or 
incorrect shooting angles, you can use the Fix/Enhance function to improve the video 
image.

Improving Video Quality and Correcting Color

1. As you have done 
previously, add a title 
template to the beginning 
of the video production.

2. Drag a video clip onto the 
video track and then click 
Fix/Enhance.
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3. Select the Video 
Enhancement opiton. 
Next, change the degree 
of enhancement on the 
video as required.

4. Select White Balance. In 
the settings panel, select 
the White calibration 

box and then click .

Note: White calibration 
corrects the color of the 
video clip. By selecting 
which portion of the video 
image is supposed to be 
white, the other colors are 
adjusting accordingly to be 
more vivid and true.

5. When the eye-dropper is 
displayed, click what 
should be white portion 
in the left panel.
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5-2 Video Cropping 
If the original source video was shot incorrectly, for example leaving too much space 
above or below the principle subject, you can use the video cropping tool to crop the 
excess video and zoom in on the video image.

6. The right panel displays 
the corrected background 
color. Click OK to exit 
the dialog.

7. The image quality was 
improved.
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1. Select the video on the 
timeline and then click 
the Power Tools button.

2. Select the Video Crop 
option and then click 
Crop Video.

3. When this message 
appears, click OK to 
continue.
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4. In the Crop Video 
window, click the first 
keyframe and then resize 
frame as required. Note 
the preview window on 
the left that displays the 
changes.

5. Click  and select 
Grid Lines. When the 
sub-menu is displayed, 
click the desired grid 
lines.

Tip: Grid lines help you 
align media in the video 
frame.

6. Move the timeline 
indicator to the last 
keyframe and then click 

 to duplicate video 
crop.
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5-3 Adding Subtitles to Video 
You can add subtitles to your video production if the audio contains dialogue in a 
foreign language, or you want to expand the intended audience for videos you post to 
YouTube or Facebook.

7. Click Duplicate 
Previous Keyframe in 
the pop-up menu.

Note: The duplicate 
keyframe function copies 
properties of the keyframe 
before or after it on the 
keyframe timeline.

8. Click OK to close the 
Crop Video window and 
save your changes.
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1. Click  to open the 
Subtitle Room.

Note: It is easier to type all 
subtitles in a text file first 
and then import the file into 
CyberLink PowerDirector.

Note: You can import 
subtitles in the .txt and .srt 
format.
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2. Click  to resize the 
editing window of you 
want to see text file along 
side the program. Open 
the text file that contains 
the subtitles for your 
video production. 

3. Click  to preview the 
video.

Note: You can also print out 
the text file for reference.

4. When the video clip is 
playing, you can click 

 to add a subtitle to 
the subtitle track. A red T 
icon  is added for each 
new subtitle.
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5. Repeat the previous steps 
until all the required 
subtitles are added. You 
can click Pause to stop 
the preview.

6. Click  to maximize 
the editing window.

Note: When all the subtitles 
are added, the red T icon is 
hidden.

Tip: You can drag the 
preview window border to 
resize the panel if some of 
subtitle buttons are hidden 
because of the limited panel 
size.

<Before resizing>
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<After resizing>
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Importing Subtitle Text

1.  (Following the previous 

example) Click  to 
import the previosuly 
prepared subtitle text file.

2. In the Open dialog, 
browse to the file, select 
it, and then click Open to 
continue.

3. When the warning 
message is displayed, 
click OK.
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Change the Subtitle Text Format

4. The subtitle file is 
imported, and all subtitles 
are replaced.

Note: You can modify the 
start time and duration of 
each subtitle directly on the 
subtitle track.

5. Click play to preview 
your production with 
subtitles.

1. Click  to change 
the subtitle’s format.
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2. In the Font dialog, 
change the font type, 
size, and color as 
required. Select the color 
box of Text to change the 
font color.

3. Select the desired color 
and then click OK.

4. Click Apply to All to 
continue.

Note: Clicking Apply to All 
applies the changes to all of 
the current subtitles on the 
subtitle track. If you just 
want to just change the 
current subtitle, click OK.
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If the length of the subtitle is too long to display in the video frame, you can insert a 
line break.

5. The subtitle format was 
modified.

1.  (Following the previous 
example) Double click on 
the subtitle to edit the 
subtitle text.

2. Move the cursor to the 
appropriate position and 
the press the [Enter] key 
on your keyboard.
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5-4 Adding a Watermark 
You can add image watermarks into your video production, if you want to include a 
production logo or other image..

3. The subtitle is split into 
two lines.

4. Open the Font dialog 
(refer to the last example) 
and then change the 
alignment of the subtitle 
to Align Multiple Text 
Center. Click OK to save 
your changes.
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Adding a Watermark

1. Drag the watermark 
image to a track.

2. Extend the added image 
clip so it's the same 
length as the main video 
clip. Click Modify to 
open the PiP Designer.
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Changing Watermark Opacity

3. If you need to add a 
shadow to the watermark, 
select Apply shadow and 
then click the box beside 
the checkbox. The 
Shadow dialog is 
displayed.

4. Change the Distance 
value and the shadow 
direction until you get the 
desired results. Click 
Close to exit.

Note: If you want to change 
the shadow direction, simply 
click on a direction in circle 
directly. Do not try and drag 
the direction indicator.
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1. Click .

2. Change the value of the 
Opacity. The greater the 
value, the more 
transparent the image 
becomes.
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5-5 Copying and Pasting Titles
You can copy a completed title template and paste it on another track. Utilizing the 
Copy & Paste function will save you a lot of time, and allow for all your templates to 
have the same format, if required.

Note: The preview window 
instantly displays the 
Opacity change.

1. Select a title template and 
then right click on it the 
timeline. When the pop-
up menu is displayed, 
click Copy.
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5-6 Creating PiP (Picture in Picture) 
Effects 

Media that displays over other media in your production is called the PiP (Picture in 
Picture) effect. These examples will demonstrate how to make more advanced PiP 
effects in CyberLink PowerDirector.

2. Move the timeline 
indicator to the desired 
position and then right 
click on the timeline 
again. When the pop-up 
menu is displayed, click 
Paste.

3. Double click on the 
pasted title template to 
open the Title Designer 
and edit the text as 
required.
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1. Drag a media clip to the 
desired video track.

2. Drag the video clip you 
want to use as the PiP to 
another video track.

Note: the PiP clip needs to 
be below the background 
clip on the timeline.

3. In the preview window, 
change the position and 
size of the PiP video clip.
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4. Select the PiP video clip 
and then click Modify. 
The PiP Designer opens.

5. Select Apply chroma 
key option and then click 

.

6. Using the eye dropper, 
click the main 
background color in the 
video image and then 
change the intensity level 
until the background 
disappears. Click Close 
to continue.
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5-7 Using Multi Trim
In a long video clip, you can divide the clip into several portions using the Multi Trim 
function. You can keep the portions you want and delete the unnecessary ones.

7. Click OK.

8. You sucessfully created 
an advanced PiP effect.
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1.  (Following the previous 
example) Select a video 
clip on the timeline and 
then click Multi Trim.

Tip: the available functions 
of Multi Trim are outline in 
the image on the left.

2. Move the timeline 
indicator to the first 
position and then click 

.

Tip: When you click  , a 
red mark displays on the 
timeline to indicate the mark 
in position. 
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3. Move the timeline 
indicator to next position 

and then click .

4. The trimmed portion is 
added to the trimmed 
portions area.
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Adding a Second Trimmed Video Portion

1. Move the timeline 
indicator to another 
position and then click 

.

Note: To find the exact 
trimming position, you can 
use the timeline magnifier or 
the playback controls.

2. Move the timeline 
indicator to the ending 
position and then click 

.
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3. The second trimmed 
portion is listed in the 
trimmed portions area.

4. Repeat the previous steps 
until all portions have 
been trimmed. Click OK 
to exit.

Note: To change the length 
of a trimmed portion, you 
can move the mouse to its 
beginning or ending. When 
the dual-arrow cursor is 
displayed, drag the cursor to 
manually resize it.
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5-8 Reducing Audio Noise in Video Clips
See the following steps to reduce unwanted noise in a video.

5. The source video clip is 
replaced by the three 
trimmed video portions.

Note: The trimmed portions 
will only be saved in the 
project. The source video 
clip is not changed.

1. Select a video clip onto 
the track and then click 
Fix/Enhance.

2. Select the Audio Denoise 
option, and then the type 
of noise that needs to be 
removed. Use the degree 
slider to adjust the 
amount of denoise.

Note: Stationary noise is 
audio echo that can occur on 
audio recorded indoors.
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5-9 Muting Video Clips
The following example outlines how you can mute the audio in a single video clip on 
the timeline.

Tip: When you click  to 
close the Fix/Enhance 
dialog, a lightning icon is 
shown on the on the clip to 
indicate denose was applied 
to it. 
Click Apply to All to apply 
the same amount of denose 
to all the video clips on a 
video track, especially if 
they were all recorded in the 
exact same environment.

1. Right click on the video 
clip in the timeline and 
then click Mute Clip in 
the pop-up menu.
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5-10 Boosting the Volume Video Clips

See the following example on how to boost the audio level of a video clip if the original 
recorded volume is too low.

2. The volume level line of 
the audio clip is hidden, 
indicating that the audio 
was muted.

1. Select the desired video 
clip.

2. Move the mouse to the 
beginning of the video 
and then click on the 
volume line to add a 
keyframe.
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5-11 Exporting your Production 
CyberLink PowerDirector 9 allows you to export your production to many different 
formats. In the following example, you will learn how to export your production to a 
.WMV file. The .WMV format is a popular video format that is supported by many 
players, such as the Windows Media Player.

3. Drag the keyframe up to 
boost the volume.

4. Repeat the steps for 
adding a keyframe at the 
end, and then drag it to 
same level so the audio 
level is consistent.

5. The video clips audio 
was increased.

Note: You can also perform 
the same function in the Mix 
Audio Mixing Room or in 
CyberLink WaveEditor.
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1. Click Produce.

2. Click .WMV and set the 
profile type to Windows 
Media Video 9 HD High 

Quality. Click  to 
display the Save As 
dialog.

3. In the Save As dialog, 
select where you want to 
save the WMV file, give 
it a custome file name, 
and then click Save.
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4. Click Start to start 
producing your .WMV 
video.

5. CyberLink 
PowerDirector will 
produce your video.

6. Once productionis 
complete, the .WMV is 
included in your media 
library. Save your project 
to have it included in the 
project.
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This chapter continues with the overview of some of the more advanced, but powerful 
editing techniques in CyberLink PowerDirector 9.

6-1 Applying Motion to PiP Effects
You can easily add movement to PiP effects, whether they are objects, images or even 
video clips. The following example takes you through the steps to apply motion to PiP 
effects.

Adding Background Image
As before, add a background into your video.

Adding an Image Mask
If you only want to use part of an image or video clip, you can use a mask to block out 
unwanted portions of the clip.

1. First, import all media 
files you want to use in 
your video production 
into the media library.

2. In the Explorer View, 
select Backgrounds and 
then drag one of them to 
the first track on the 
timeline.
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1. In Explorer View, select 
All Content to display all 
the media in your ilbrary. 
Select a video clip and 

then click  to capture 
the first frame as an 
image.

2. Drag the new image to 
the timline, below the 
background image. Set 
the length of the image to 
be the same as the 
background. Click the 
Modify button to 
continue.

3. In the PiP Designer, 
click  to display a 
list of masks.
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4. Select a mask that will 
block out the unwanted 
portions.

5. Change the position and 
size of the mask, and 
move it so that I best 
covers the unwanted 
portions.
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Apply Movement to PiP

1. In the PiP Designer, 
click  and select the 
a motion path template.

2. Click the first keyframe. 
If necessary, change the 
image position and size. 

Click  to go to next 
keyframe.

3. Click  to delete any 
unnecessary keyframes, 
if required.
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4. Go to the next keyframe.

5. If necessary, change the 
image size and position.

6. Go to the final keyframe 
and then click .
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7. Select Duplicate 
Previous Keyframe in 
the pop-up menu.

8. Click Play to preview the 
applied motion.

9. Select the Fade-in and 
Fade-out effect options. 
Click OK to exit the PiP 
Designer.
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6-2 Flipping PiP Images 
You can flip PiP images vertically or horizontally. See the following example.

Tip: You can drag a specific 
keyframe in the timeline to 
fine tune the motion path.

1.  (Following the previous 
example) Drag an image 
to track 3 and then click 
Modify.
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2. In the PiP Designer, 
click  to display 
the list of masks. Select a 
mask and then change its 
position.

3. Click the Properties tab 
and then select Enable 
flip object, and then Left 
to right.

4. Select the Mask tab and 
then resize the mask.
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6-3 Adding Titles Over PiP Effects
You can add title effects in conjunction with PiP Effects, to create an eye catching 
sequence.

5. Click the Properties tab 
and then resize the image 
if necessary.

6. Click the Path tab and 
then select the Fade-in 
and Fade-out effect. 
Click OK to exit.
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1. Go to the Title Room 
and then drag a title 
template to the title track.

2. In the Title Designer, 
enter the required text in 
to the title text box and 
then click OK.

Tip: Add animated title 
effects to your titles that 
sync with the other 
movement for a more 
engaging sequence.

3. Resize the title clip as 
required.
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6-4 Working with Media on the Timeline 
CyberLink PowerDirector 9 provides you with the most flexible editing possible, with 
up to 100 tracks available. You can insert, move, or replace any media on a specific 
track at any time, without restriction.

Splitting Video 

1. Drag a video clip from 
the media library to the 
timeline.

2. Move the timeline 
indicator to the desired 
position and then click 
Split. The original clip is 
cut into two independent 
clips.
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Inserting Media Between Two Split Clips

1. Capture another snapshot 
from a video clip in the 
library, and then drag it 
between the clip we split 
in the last example.

2. Select Insert in the pop-
up menu that displays.

3. The captured image was 
inserted between the two 
clips.
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6-5  Using Chroma Key 
Chroma key can also be used on both images and video, and when done correctly, adds 
a unique effect to your video.

Masking the Video Background - Chroma Key

1. (Following the previous 

example) Click  in 
the timeline to add a 
video track above track 1.

2. Drag a background to 
track 1.
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3. Select the captured image 
clip (from the previous 
example) and then click 
Modify.

4. In the PiP Designer, 
select Apply chroma 
key.

5. Click .

Note: When you apply the 
chroma key, the program 
will make the background 
invisible. You can click the 
eye dropper icon to access 
the Chroma Key window 
for further settings.
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Adding Movement

6. In the Chroma Key 
window, use the eye 
dropper to select the 
background color. 
Change the intensity 
level until the 
background disappears. 
Click Close to exit.

1. Click .
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2. Click  so that no 
motion is added to the 
image.

3. Move the timeline 
indicator to a desired 
position and then click 

 to add a keyframe.

Note: If you don't want any 
movement between the two 
keyframes, make sure the 
keyframes have the same 
properties.
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4. Move the timeline 
indicator to next position 
and then click .

5. Move the image to a new 
position.
224



Advanced Editing Techniques and Media 
Management in CyberLink PowerDirector - Part III
Adding Borders to PiP Effect
To highlight the an effect, you can add a border with a bright color onto the image.

6. Move the timeline 
indicator to the next 
position and then click 

. When the pop-up 
menu is displayed, select 
Duplicate Previous 
Keyframe.

Note: The following 
describes how PiP motion 
works:

• Step 1~2: Pausing 
motion.

• Step 2~3: The image 
moves to the right.

• Step 3~4: Image pauses 
briefly.

• Step 4~5:The image 
returns to the center of 
the frame.

7. Click OK to finish.

Tip: You can click  or 
 to quickly go to the 

previous or next keyframe.
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1. In the PiP Designer, 
click the Properties tab 
and then select Apply 
Border. Click  to 
change the border color.

2. Change the settings as 
required. If you would 
like to change the border 
color, click the color box 
in the Uniform color 
option. 

3. Select a color and then 
click OK.
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Adding Title Text 

4. Click Close to exit the 
dialog.

5. Click OK to finish.
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1. Open the Title Room and 
then drag a title template 
to the timeline.

2. In the Title Designer, 
enter the profile in the 
box and then change the 
color, size, and height of 
the font.
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3. Add multiple lines of 
text, separately them with 
line breaks (press 
<Enter> on your 
keyboard).

Note: You can highlight and 
apply changes to the text, 

separately. Click  to 
change the font.

4. If necessary, click the 
color box to change the 
border color.

Note: All text in the title box 
uses the new border settings 
if the entire title box is 
selected.
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5. You can highlight the 
expert’s name and change 
the border color. 

Note: Only highlighted text 
wil be changed. If the entire 
text box is selected, then all 
the text is changed.

6. When all settings are 
done, click OK.

7. Make sure the title clip 
matches the length of the 
clip is will play over.
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6-6 Using the Mosaic Blur Effect to Mask Content 

If you have content in your video production that you want to blur out, such as a face or 
product logo, you can do this using the mosaic effect. 
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Using the Mosaic Effect

1. Click  to display the 
Effect Room.

2. Drag the Mosaic effect to 
the effect track and then 
click the Modify button.

Note: The effect clip should 
be directly below the media 
clip that has the content you 
want to blur. 

3. In the Effect Settings 
window, click Mask.

Note: In the Mask window 
you can set the sizeand 
placement of the Mosaic 
effect.
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Dynamic Mosaic Blur Effect
If the content you want to blur out moves in the frame, you can use keyframes to resize 
the mosaic effect to compensate.

4. By default the mosaic 
effect covers the entire 
screen.

5. Change the size and 
position of the mask so 
that is covers the required 
area of the media clip. 
Click OK to continue.
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1. Select the Mosaic effect 
clip and then click the 
Keyframe button.

Tip: You can add keyframes 
to any effect, for more 
precise control on how the 
effect is applied in your 
video production.

2. Click Play to locate the 
first frame that has the 
content you want to blur 
using the mosaic effect.
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3. Click  to add a 
keyframe.

4. Click Mask.

5. Change the position and 
size of the mask. Click 
OK to continue.
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6. Click Play to find the 
next frame that has the 
content you want 
covered.

7. Add a keyframe and then 
click Mask.

8. Change the position and 
size of the mask. Click 
OK to continue.
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6-7 Adding Two PiP Effects Side by Side
You can easily add two PiP images side by side in the video frame, so that they display 
together on screen as if they were originally shot together.

9. Repeat the previous steps 
until the content is 
completely blurred using 
the mask effect..

1. Drag the first clip to one 
track and then drag the 
second image to another 
track. Click  and then 
enable the Grid Lines. 
Click 2X2 in the pop-up 
menu. 

Tip: Grid lines help you 
make precise alignment of 
all the media in your video 
productions.
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2. Ensure the media is lined 
up on the timeline and is 
the same length.

3. Using the grid lines, 
ensure the media is 
aligned in the preview 
window.

4. If necessary you can add 
titles over the content.
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6-8 Sharing your Video on YouTube
Once you are done editing your video, CyberLink PowerDirector can upload it directly 
to YouTube so that you can share it with others.

Note: You can add a border 
to separate the two media 
clips in the PiP Designer.

1. Click Produce.
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2. Click .

3. Enter in your account 
information and change 
the settings as required. 
Click Start to continue.

Tip: If you do not have an 
account on YouTube, click 
the Sign up to YouTube 
link.

4. When the YouTube 
Agreement dialog is 
displayed, select the 
statement agreement 
option and then click 
OK.
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5. Your video clip will start 
producing.

6. Once it has created a 
video file, CyberLink 
PowerDirector uploads it 
to YouTube.

7. Once uploaded, click the 
Check out your video 
on YouTube link.
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8. After it has been 
rendered, you can view 
your video on YouTube.
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This chapter outlines some miscellaneous features and editing functions you may find 
useful when creating a video production.

7-1 Creating a Custom Cell Phone Ring - 
WaveEditor 

CyberLink WaveEditor is a new tool in CyberLink PowerDirector 9 that you can use to 
edit the audio in your projects, including adding effects to existing music or recorded 
audio.

Note: you can edit audio that is on the timeline directly in WaveEditor by clicking the 
Edit Audio button, or open the program directly from the Windows start menu.

7-1.1  Opening an audio file

1. Click Start > All 
Programs > CyberLink 
WaveEditor.
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2. To import audio into the 
program, click .

3. Browse to the media you 
want to import, select it, 
and then click Open.

Note: CyberLink 
WaveEditor supports the 
following audio formats:
.wav, .wma, .mp3 and .m4a.

4. If you receive the 
following message, click 
OK.
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7-1.2  Basics of WaveEditor
The following outlines some of the basic editing features in the CyberLink WaveEditor 
program.

Playback Controls

5. The audio file was 
imported.

In the bottom-left corner of 
the editing panel, there are 
three playback control 
buttons:

 Play the audio
 Stop playback
  Pause playback
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Selecting Audio
You can select portions of an audio clip to apply effects and fixes to only the selected 
portion.

Cropping Audio

Click the editing panel to 
display the selection 
indicators. Move the left 
indicator to mark the 
beginning and move the 
right indicator to mark the 
end.

1. When you have selected 
the portions of the audio 
clip you want to keep, 
click  to crop out the 
unwanted portions.

Note: When you crop the 
audio, the unselected 
portions are removed.
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Export the Modified Audio
You can save the edits you made as a new audio file, and even convert the original 
audio to another version.

2. After cropping, only the 
selected audio clip 
remains.

1. Click File > Save Track 
As and the Save As 
dialog is displayed.

2. Select where you want to 
save the new file and then 
enter a file name. Click 
Save to exit.
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7-1.3  Adding Fade Effects
See the following steps to add a fade effect to your audio.

1. Click the editing window 
and then highlight where 
you want to apply the 
fade.

2. Click Fade and the 
Effect Fade dialog is 

displayed. Click  and 
the volume will be 
adjusted automatically. 
Click  to preview the 
clip. Click OK to exit.

Note: After clicking , 
CyberLink WaveEditor auto 
adjusts the volume and 
applies the fade out effect. 
You can also manually 
customize the fade if 
required in the effect dialog.
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3. The fade-out effect is 
applied.

Tip: You can zoom in on the 

timeline by clicking .

4. Select the beginning part 
of the audio and then 
click Fade to add a fade-
in
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5. In the Effect Fade 

dialog, click  and click 
OK. The fade-in effect is 
applied.

Tip: You can click  to 
view the entire audio track.
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7-1.4  Boosting Audio

1. Click Boost.

2. In the Effect Boost 
dialog, increase the 
volume and then click 
OK.

Tip: You can click Play to 
test the new volume.
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7-1.5  Recording Audio
In CyberLink WaveEditor you can record custom audio using a microphone.

3. The Boost effect is 
applied.

1. Click File > New 
Project.
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2. Click .

Tip: Make sure your 
microphone is plugged in 
before recording.

3. Click  to start 
recording.

4. When you have recorded 
the audio, click Stop.
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7-1.6  Reducing Unwanted Noise
You may encounter unwanted noise if the audio was not recorded in a professional 
studio. You can use CyberLink WaveEditor to reduce the unwanted noise.

5. Enter a file name for the 
new audio file and then 
click OK.

 

6. Click Close.

7. The audio was recorded.
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1. Display the Denoise 
options.

2. Click Noise Reduction 
in the Denoise effect list. 
Select the noise type first 
and then use the slider to 
adjust the level of 
reduction applied. Use 
the play button to 
preview, and then click 
OK once you are 
satisfied.

3. Click Play listen to the 
fixed audio.
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7-2 Support for RAW Images from DSLR 
Cameras 

CyberLink PowerDirector 9 supports the editing of RAW image files directly from 
DSLR cameras. The supported RAW image formats are outlined below. For a complete 
list of the supported RAW image formats, see: http://www.cyberlink.com/products/
powerdirector/overview_en_US.html.

Brand Raw file extension

Nikon .nef

Cannon .crw .cr2

Fuji Photo Film .raf

SONY .arw

OLYMPUS .orf

PENTAX .ptx .pef

Kodak .kdc

Minolta .mrw

Adobe .dng

Hasselblad .3fr

Sigma .x3f
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7-2.1  Importing RAW Images

1. In the Explorer View, 
add a new folder.

2. Click  and then 
select Import a Media 
Folder.

Note: You can copy all 
imported files to a folder 
first and then import the 
entire folder. All files will be 
imported at once.

3. When the dialog is 
displayed, select the 
folder and then click OK.
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7-2.2  Magic Style Templates 
CyberLink PowerDirector 9 has enhanced the Magic Style function, as it now includes 
17 2D styles and six new 3D styles. Utilizing Magic Style can greatly shorten your 
production time.

4. Click Yes to All.

Note: All imported RAW 
image files are converted 
into the JPG format for 
editing.

5. Images are imported.

6. Once imported, the 
images are available in 
the media library.
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1. Add some media to the 
timeline, enter the 
Storyboard view, and 
then select all clips. Click 

 to continue.

2. In the Magic Style panel, 
select the desired style 
template and then click 
Preview.

3. The program creates a 
video with the applied 
style.
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7-2.3  Preview in the Media Viewer
You can preview the video in the media viewer, instead of the preview window. The 
media viewer is a full-screen viewer that gives a better feeling for your final 
production.

4. You can preview the 
video in the Preview 
window.

1. In the preview window, 

click .
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7-2.4  Applying Magic Style
After previewing your project, you can click Apply to add the Magic Style effect onto 
the video track.

2. Select Launch Media 
Viewer in the pop-up 
menu.

3. Click  to view your 
production at full screen.
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1. Select the desired media 
clips on the track and 
then click Magic Style. 
Select the desired style in 
the Library Window 
and then click Apply.

2. The pop-up window 
displays the progress.

3. The style was applied to 
the selected clips.

Note: Applying MagicStyle 
will replace the existing  
media on the corresponding 
tracks. 
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7-2.5  Editing the Resulting Styled Video
When using Magic Style of Magic Movie, CyberLink PowerDirector creates a video 
project with your media to get you started. You can then edit these clips further, to fit 
your requirements. For example, you can edit the title template that was auto added by 
the Magic Style.

1. Double click the desired 
title template added. 
When in Title Designer, 
edit the text as required 
and then click OK.

Tip: You can change the 
style, size, and color of the 
font in the Title Designer.

2. Edit any other clips as 
required until you are 
satisfied with your 
production.
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             Miscellaneous Tips and Editing Tricks
7-2.6  Exporting your Project as H.264 AVC Video 
File

If your original media is in a high resolution, you can export your project as an H.264 
AVC video to better preserve the original quality.

1. Click Produce.

2. Click H.264 AVC and 
then change the profile 
settings to fit your 

preference. Click  
to specify an output 
location.
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3. Locate where you want to 
save the file and the click 
Save.

4. Click Start.

5. CyberLink 
PowerDirectort starts 
rendering your project 
and creating the new 
video file.
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             Miscellaneous Tips and Editing Tricks
6. The video was created 
and saved to the specified 
folder.
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